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Overview

The purpose of this document is to explain how to debug your BASIC programs written in
BASCOM-AVR on the MINI-MAX/AVR-C board using ATMEL’s JTAGICE mkll debugger ( also
known as ATJTAGICEZ2 ). This debugger uses the USB port to communicate with the host PC
and the JTAG port to communicate with MINI-MAX/AVR-C board.

This combination allows you to do full source level debugging of BASIC programs on the MINI-

MAX/AVR-C board, including capabilities such as breakpoints, single stepping, watching
variables and other features.

Hardware Setup

Connect the JTAGICE mkll header to MINI-MAX/AVR-C’s JTAG connector as shown:

JTAGICE mkll is connected to the PC through the USB port. There is no need for a separate
power supply for JTAGICE mkll as it is powered from the USB port. MINI-MAX/AVR-C should be
powered by its own power supply ( 6VDC adapter ).
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Software Setup

1. Install AVR Studio

AVR Studio® 4 from ATMEL (www.atmel.com) is a professional Integrated Development
Environment (IDE) for writing and debugging AVR® applications in Windows®
9x/NT/2000/XP/Vista(32- and 64-bit) environments. AVR Studio 4 includes an assembler and a
simulator.

ATMEL AVR Studio is available as a free download from ATMEL website:

Please install AVR Studio and USB driver BEFORE connecting JTAGICE mkll to your PC.

Download and install AVR Studio 4.12 SP3 or later from http://www.atmel.com/

A¥YRStudiod - InstallShield Wizard x|

Welcome to the InstallShield Wizard for AYRStudiod

Hest > ] Cancel

InstallShield

In order to use the JTAGICE mkll, it is required to install the USB driver. Check the
Install/Upgrade USB Driver checkbox, and the USB Driver will be installed automatically:
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AVRStudiod - InstallShield Wizard

Select Features

warit to install, and de he features you do not want ta install

Insali5Hield | < Back || Mest = | | Cancel |

When AVR Studio/USB driver installation is finished, please attach the USB cable to both your
PC and JTAGICE mkll. JTAGICE mkll will be powered from the USB.

If this is the first time the JTAGICE mkll is connected to the computer, the dialog below will
appear:

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

This wizard helps you install software for:

AVRISP mkll

'i') If your hardware came with an installation CD
&2 or floppy disk. insert it now.

What do you want the wizard to do?

(®ilnstall the software automatically [Recommended}
O Install from a list or specific location [Advanced)

Click Next to continue.

Bacl uexb ] [ Cancel ]
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Please, click "Next" a couple of times and wait until the installation process completes. It may
take from a few seconds up to a few minutes. If the AVR Studio for some reason can't detect the
JTAGICE mkll, try to restart the computer in order to get the driver properly loaded.

2. Install BASCOM AVR

Start installation by running setup.exe:

Jl3

Welcome to the BASCOM-AVR
Setup Wizard

Thiz will ingtall 1.11.9.5 an your computer.

[t iz recommended that vou claze all other applications before
continLing.

Click Mest to continie, or Cancel bo exit Setup.

Cancel |

Click Next. Accept the license agreement:
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5! Setup - BASCOM-AVR =101 x|

Licenze Agreement
Pleaze read the following important infarmation before continuing. '

Pleaze read the following Licenze Agreement. vou must accept the terms of thiz
agreement before continuing with the installation.

BASCOM-AVR f’

MCS Electronics MO-MOMSEMSE LICEMSE STATEMENT AMD LIMITED
WARRANTY

IMPORTANT - READ CAREFULLY

Thiz licenze statement and limited warranty constitutes a

leqal agreement ['License Agreement''] between you [either

az ah individual ar a single entity] and MCS Electronics

for the software product [Software’] identified above,

inchuding any software, media. and accomparying on-line or ;I

{* i accept the agreement

| do not accept the agreement

< Back I Mest » I Cancel

Click Next. Read the important information:

5! Setup - BASCOM-AYR (=]
Information
Pleaze read the following important infarmation before continuing. '

wihen pou are ready to continue with Setup, click Mest.

Thark pou for uzing BASCOM-A0E -

Thiz file containg some additional info on BASCOM-AWE.

HHMREMMMNEEN |MF||:IHT",:,"NT EER P R P

"When you get an Error 123 vou probably don't have a printer inztalled
Inztall a printer [HP Lazeret 4 for example] and run again.
v'ou dio hot heed to connect a printer, but a printerdriver must be installed.

"When pou get an OleSyzEror, reboot Windows and run SETURP again.
After reboating again, run BASCOM again.

Whe_n__l,n:nu ins_tall the zoftware on an NT A 2000=PASTA maching vou need ;I

< Back I Mest » I Cancel |

Click Next. Select the path to install. It is recommended to use the default path:
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5! Setup - BASCOM-AVR =101 x|

2
Select Destination Location

where should BASCOM-4WR be inztalled? '

'.J Setup will inztall BASCOM-AYE inta the fallowing folder.

To continue, click Mest. [F vou would like to select a different folder, click Browse,

C:%Program Filez\WCS Electroniczh\BASCOM-4WE Browse. .. |

At leazt 28.1 MB of free digk space is required.

< Back I Mest » I Cancel

Click Next. Specify the Start Menu folder for program shortcut. It is recommended to use the
default name:

5! Setup - BASCOM-AVR =101 x|

Select Start Menu Folder
W'here should Setup place the program's shortcuks? '

Setup will create the program's shartcuts in the fallowing Start Menu falder.

To continue, click Mest. [F vou would like to select a different folder, click Browse,

kCS Electroni N B Browse. .. |

< Back I Mest » I Cancel

Click Next. BASCOM-AVR will be installed:
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5! Setup - BASCOM-AVR =101 x|

Installing

Pleaze wait while Setup installs BASCOM-AYR on pour computer. '

Estracting files...
C:\Program Filez'#C5 ElectronicehBAS COM-2WRYSAMPLE S 2Ch24LCR15.CFG

.

Click Next. Installing Additional files dialog will appear. This may be blank. This is OK:

5 Setup - BASCOM-AYR =10l

Additional Files 1

Installing additional filez '

Inztalling additional files

Click Next. When asked to restart your computer, select Yes and click Finish. Make sure that you
have saved your data in other open applications before restarting your computer.
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Follow further instructions that came with your BASCOM-AVR compiler to finish setup. For
example, if you have full licensed version of BASCOM-AVR, you may need to copy the license
file BSCAVR.DLL to your BASCOM-AVR folder ( default path is C:\Program Files\MCS
Electronics\BASCOM-AVR )

3. Start AVR Studio

@ ACcessories b

{ﬂ Windows Media Plaver |

G Atmel AYR Taols Q [F] Avr Battery Studio
[T Axon Data ¥ GU AYR QTouch Studia
" C

@ Bitvise Tunnelier % AVR Studio 4

- 3
) Camon Utilities b 5 AVR Loeledaln

Location: Z:\Program Files\akmellAvwR, Tu:n:uls'l,.ﬂvrStuu:Iiuﬂl

) ClisntAP » %' AR

3
) CwsHT » /B Plug-in Maniager

Welcome to AVR Studio dialog will appear:

Welcome to A¥R Studio 4

@ Mew Project ‘ Open
Recent projects | h odified |
'@ IpiHinefollower-pid. aps 18-Jul-2008 17:44:16

Wer 4.16.628 ¥ Show dialog at startups

<< Back | i [= I Eimzh Cancel Help

Click Cancel.
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Select Open File from File menu:

-
2
K
a
g
<

fsen| mEG @GSO R

l6uild | @ Message |5 Find in Files | -3 Breakpoints and Tracepoints

L]
| @rbox... | (D 220 | ) vahoo!...| @ 5Fr... o] Blevors..|Fg2se. o @oeou..| | 2wi. -] G sope.. | Tomus...| m 1926, | 8 windo... | # 2¢ea.. - § Lipa-.. [ AR

File Open dialog will appear:

open R &

Lok jr |B BIPOM

by Documents

W
a
by Computer

x|« ® ek EE-

= adc.bas: I0_PDE.0E]

ade.cfg I0_PDE.RPT

|3 hella.bas |3 io_pd?.bas

HELL, BTN I0_PD7 EIN

hella.BM io_pd7.BM

hello.cfg I0_PD7.DEG

HELLC. DG I0_PD7.HEX

HELLC, HEX I0_PD7.0B]

HELLC, OB I0_PD7.RPT

HELLOWRPT  |Z]tblled.bas

ginjdﬁ.has tI:nlIed.n:Fg

10_PD6,BIN

in_pdé, M

I0_PDE.DEG

I0_PDE.HEX

File name: I j Open I
Files of type: I,-'.‘-.II Filez [*.7] j Cancel |
Open as I.-“-‘-.uh:u j
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Select the Object file ( .obj ) that corresponds to the BASCOM-AVR program that you wish to
debug. For example, if the BASCOM-AVR program is tb1led.bas, the object file name is

tb1led.obj.

Save AVR Studio Project File P |
Savein: | | BIPOM x| BB

Name ~ |~|Date.. || Type || Size  |-]Tacs ||
Mo items match your search.

File pame: [TETLED OBJ.zps | Save
Save as type: IA\-’R Studio Project Files {".aps) ﬂ Cancel |

AVR Studio will create a project for debugging this object file. To ensune optimal debugging, AVR Studio’s project
file should be located at the root of the original sounce file project. if the orginal source is not available, you can
save the project file at the same place as the ohject file
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Select Device and Debug Platform dialog will appear. Select the debug platform as JTAGICE
mkll and Device as ATMEGA2560. this is because the microcontroller on the MINI-MAX/AVR-C
is ATMEGA2560.

Select device and debug platform

‘er 4.15.623

— Select debug platform and device

Debug platform:

Device:

AR Dragon ATmegalBl ;I
AR OME! ATmegalBBF
AR Sirmulataor ATmegal BEPA
AR Simulatar 2 ATmeasl63 [ ]
ICE200 ATmegal B3P
ICE40 ATmegalBa
ICESD ATmegalBHWA
JTAG ICE ATmegalEU4
JTAGICE mkll AT megaz2o6l
ATmega2561
ATmegad? LI

Paort: |Aut0 'I ™ Open platform options nest ime debug mode is entered

<< Back | Hestes

Finizh LCancel Help
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The following screen will appear. BASIC source code is not yet displayed. This is OK:

File Project Build Edit View Tools Debug Window Help
e R -1 B RV e
: [Trace Disabled % L5k T e e

NEEO v EEEE!A

- x
Progan Courter B01FO00 [sdgess [vabe [ous |
SackPorter  GIFF 1) AD_CONVERT
Xponter 000000 ) ANALOG_CON
Ypoiter K000 FEE £ e mimyel 4B} B00T_LOAD
Zpairter 0000000 2] LBcru
Cyde Counter 0 1 o ===t
Frequency § 4 S EXTERNAL_IM
Stop Watch o
SREG I e 5

6
7
o
03
i
B
C
D
E
F
0
1
12 4 E2 PORTL
13 5P
1
3
3 X
g & TIMER_COUN
5 8 TIMER_COUN
A @) TMER_COUN
&) TMER COUN
HRITWI
3 USARTO
33 USARTI
1 £ WATCHDOG
Loaded plugn STK00
081
<l |
Build | @ Message |54 Findin Files | L@ Breakpoints and Tracepoints |
ATmega2560  JTAGICEMKI  Auto Stopped = CAP NUM OVR

Lsa| mEO @G S0P | @wbox... | @ 3225 | i) vahoo!...| @5 Fr... +| Heror .. | Bg2se.. -| @ovom...| | 2wi. -] & sope.. | Toemus...| 12| 8 windo... | £ 2ea. | f 2pant -|[ avRs. [« B G &) S25eM

Select Stop Debugging from Debug menu:

USEIF]

File Project Build Edit View Tools
NEHSY s Bpdam
ceomes % v L

VE O e

Reset Shift=Fs

e il =

Program Courter  0c01FO00 T = 3 [nddress  [vale |[Bes |
Stack Porter  D21FF ‘i i = ) AD_CONVERT
X pointer 000000 RO = '+ ANALOG_COM
Y pointer c000000 = stepout shift=FLL 3 ) B B0OT_LOAD
Zporter 0000000 3 RunTo Cursor ctrl-Fi0 e 2Bcru
Cyde Counter 0 AR P - ===t
oy o = 1S EXTERNAL I
Sop Watch Next Breakpoint an-r :
SREG 1 e New Breakpoint > =

g T @ Toggle Breskpoint o A

Remove Breskpoints

-8
3

Trace r
Stack Manitar

Show Next Statement Alt=Num
Quickwatch Shift-F3

[

2o

Select Platform and Devic

2
BE
Fah

Up/Dawnload Memory

JTAGICE mill Options
FO001F010.  FEFF
40001F019°  FFFF

21 & TIMER_COUN
8 TMER COUN
I8 TMERLCOUN
=+ & TIMER_COUN

P

43 WATCHDOG

Loaded plugin STKS00

ATmegazséd  JTAGICEMKI  Auto Stopped & CAP NUM OVR

| @ vaoor..| @srr.. | Bemora.. | Bgase.. | @svom..| | 2wi. -| G sope.. | Tomus...| @ w26, 8 wido.. | £ 2ea.. o] {3rant |[F avrs. [« B @i &) s2sem

|
=15uid | © Wessage | Findin Files | 1@ Breakpoinis and Tracepoints

Lsen| mEO @GSO TR | Qo | D
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Click on the Project tab on the left most pane. The BASIC source file appears under Include
folder. Double click on the BASIC source filename ( .bas ) to open it in the AVR Studio’s editor

( middle pane ):

AVR Studio - [C:\Users\oguz\Documents\BIPOM\tb1led.bas] N 18|
Fie Projed Buld Edi View Tools Debug Window Help _ax
DEdHd Gy U b A (R ITIEI: 293
Trace Disabled =] % P

R [ e Sllove -]

=% TBILED_OB) ! = | -
569 obect | Module:  TBILED BAS i
TB1LED.CB) ¥ Baoietons Tt Name Addess | Value | e |
‘&3 Source [read only] . 4T3 AD_CONVERT
=3 Indude [read only] * Date: 12/04-2006 '+ ANALOG_COM
(2] thiled bas | +JB)BOOT_LOAD
| Description: IED test of TB-1 board 0e
: 1@ EEPROM
© ATHEGA 2560 2%
Srogfile - 'm2560def dat" 2 S EXTERNAL N
' {TOOLKITDIR}\bascomp {SOURCEFILE} hv=64 ss=64 fr-64 chip=43 HRLITAG
. 458 PORTA
scrystal = 14745600 28 PORTB
 CONFIGURE PORTB a@ronrc
S ias Portb.0 122 PORTD
Sok Alias Porth.1 452 PORTE
Mosi Alias Portb.2 =
Miso Alias Portb LS PORTE
VELLOV_LED Alias Poxtb. 4 =/ FORTG
GEEEN_LED Alias Forth & 452 PORTH
) TED  Alia: =
BUZZER Alias Portb. 7 B PORTY
Const Ddzb_init = &HFD ‘1-output, O-input 2 2 PORTK
Const Portb_init = &HFO 4 E2 PORTL
. 3 H3asPl
Const LED_DEIAY - 250 1855 oo
' CONFIGURE_PORT B F X
Ddrb = Ddrb_init B TIMER_COUN
Forth = Forth_init 26 TMER_CON
RED LED @) TMER_COUN
Reset RED_LED 8 TIMER_COUN
Waitlis LED DELAY 3w
Set RED_IED 3
Vaithis LED DELAY 3 USARTO
' ¥ELLOV_LED 33 USARTI
Reset VELLOW_LED us
Waithis LED DELAY 22 USART2
Set YELLOW_LED 287 USART3
Waitlis LED DELAY 1 £ WATCHDOG
GREEN LED L
Reset GREEN_LED
Waitlis LED DELAY
+ GREEN ]
Waitlis LED DELAY
g
Users\oguz\Documents\BIPOM\tb1led.bas
Loaded plugn STK00
081
<l | |
=T Build | @ Message |4 Findin Fles | L@ Breakpoints and Tracepoints
ATmega2560  JTAGICE miIl Auto @ n15.Col45  CAP NUM OVR

| mEO @GSO R | Qroc [Our. | g | @5

oror 1. Mg | @ w1 2w <[ 3 Sope. | e i 0215 e | 2 |

G arant -[[ aves. [« B @ R0 s2sem
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Set a breakpoint somewhere in your BASIC program by clicking on the line where you want to
place breakpoint and selecting Toggle Breakpoint from the Debug menu ( F9 key does the same
thing ):

AVR Studio - [C:\Users\oguz\Documents\BIPOM\tb1led.bas] 18|
File Projec Build Edt View Tools [Debug | Window Help _ax
T TR T LR
4] stop Debugging Cri-shift-Fs
s
=% TB1LED_0B) =
< atri-Fs i
= Qoo ¢
@ TELED.CB) elile Neme [nddress  [vale |[Bes |
/23 source [read only] . ) AD_CONVERT
543 Incude [read oniy] ) ANALOG_CON
[ia] thiled.bas F10 — +/E) BOOT_LOAD
Shift+F11 «EcPU
ctri+F10 -+ E) EEPROM
at-Fs 1 S EXTERNAL I
LE} hv=64 ss-64 fr-64 chip=43 8076
Next Breakpoint ctri-Fo 458 PORTA
=
New Breakpoint » 42 FORTB
I 2 452 PORTC
@ Toggle Breakpoint [ @Z oo
Remae all Breakpoints =2 PORTE
- 7 2 PORTF
race 4152 PORTG
Stack Monitor #Z2 FORTH
AR
| show het statement At=Num * A Brorrd
As ‘L-cutput, O-input 4122 PORTK
54| Quickwatcn Shift-F9 4 E2 PORTL
Select Platform and Device. 857
1) TMER_COUN
Up/Download Memory 4 [ TIMER_COUN
JTAGICE kI Options At-0 2B TIMER COUN
o 8 TMER COUN
*" RED 1ED @) TMER_COUN
Reset RED_LED 8 TIMER_COUN
Waitlis LED DELAY 3w
Set RED_IED 3
Waitks LED DETAY 457 USARTO
YELLOW_LED 33 USARTI
Reset VELLOW_LED us
Waitlis LED DELAY A uomte
Set YELLOW LED 133UsARTS
Waitlis LED DELAY 43 WATCHDOG
GREEN LED L
Reset GREEN_LED
Waitlis LED DELAY
+ GREEN ]
Waitlis LED DELAY
G _'l_l
Users\oguz\Documents\BIPOMtb11 i
ge v x
Loaded plugin STKS00
<l | 2l
l6uild | @ Message |5 Find in Files | -3 Breakpoints and Tracepoints
ATmega2560  JTAGICE mkl Auto ® w303 CAP NUM OVR

Dsat| mEO @G S0P e | @rbox... | (D 220 | ) vahoo!...| @ 5Fr... o] Blevors..|Fg2sr.. o @weo...| | 2wi. -] G sope.. | Tomue...| 1926, | 18 windo... | f 2¢a.. o § arant o[ AvRs. [« B @) my0) s26Pm
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Select Run from Debug menu. The program will run until it hits the breakpoint. Program execution
will stop at the breakpoint. Both the BASIC source and Assembly language equivalent will be
shown:

embler] 181 ]|

Fle Projec Buld Edt View Tools Debug Window Help JER
DEHI S s Bad s B h N PR a9 EEE=NHOSS HR
: [Trace Disabled T % %0k T e e

[ oooooos0 Ereo 0T T2t 0er0 Toad immediate |
T +00000091:  E9B4 ouT 0204, k24 Out to 10 location =
 Vebe ] 34 Portb = Porth_init
Program Courter 0000034 +00000092:  EF80 finid R24, 02FD Load innediate — ] ]
s o 400000083 B985 ouT 006, R24 Out to /0 location
it 37 Reset RED_LED #/T)AD_CONVER]
Xponter 0021FE 2>+00000034:  382E CBI 005, 6 Clear bit in 170 register ) ANALOG_CON
Y pointer x0021C0 ke Vaiths LED_DELAY B} B00T_LOAD
S 0 +00000095: EFBA DI R24, 02FL Load imnediate =
L +00000096 E090 IDI R25, 0x00 Load immediate «EcPU
Cyde Courter 0 8 VaitMs IED_DELAY B eeprom
Frequency. 100000097:  S40EQUBE " CALL 02000000BF Call subroutine ) EXTERNAL I
Stop Watch ot RED E90TAG
+00000099: 9L2E SBI 0056 Set bit in 10 register &
SREG DNEEDOED 1 Waitls IED_DELAY 452 PORTA
4 Regiters +000000%4:  EFBA DI R24. UxFA Load innediate 22 PORTB
+0000009B: E030 DI RZ5. 0200 Ioad innediate 128 PORTC
1 Waiths LED_DELAY =
+0000003C: _94DEDDBF  CALL 0=000000BF Call subroutine )22 PORTD
12 Reset YELLOV_LED 452 PORTE
+0000009E: _a82C CBI 005, 4 Clear bit in 1/0 register 8 FORTF
1 Waiths IED_DELAY =
+0000009F:  EFBA DI R24. U=FL Load innediate 212 PORTG
+000000AD: E030 DI R25 0x00 Ioad innediate 452 PORTH
4 Waitlis IED DELAY 28 roRTy
+000000A1: _340EDOEF ~ CALL 00000008 Call subroutine -
4 =t YELLOW_LED 2FE PORTK
+000000K3: 9A2C = 0205, 4 Set bit in 10 register 152 PORTL
15 Waiths LED_DELAY =t
+000000A4:  EFBA DI R24. 02FL Load innediate =
+00000DA5:  E030 D1 R25, 0x00 Toad imnediate 2 TIMER COUN
Waitls IED_DELAY 49 TIMER_COUN
+000000k6: G40EO0EF  CALL 0200000088 Call subroutine B TIMER_COUN
47 Reset GREEN_LED 216 TMER_CoUN
+000000A8: 382D CBI 0055 Clear bit in 170 register 2 L
48 Waitlis LED_DELAY 2/ TIMER_COUN
+000000A3:  EF8A DI R24, 02FL Load imnediate 8 TIMER_COUN
+000000KA°  E030 DI R25. 0200 Load immediate PE
1 Waiths LED DELAY 3
+000000AB:  940ED0BF __ CAIL 0=000000BF Call subroutine 81 USARTO
1 Set CREEN_LED 33 USARTI
+000000AD: 32D SEI 02055 Set bit in 100 register 5 usaRT2
5 Waitls LED_DELAY &
+000000AE:  EFBA 1DI R24, DxFh Load inmediate 287 USART3
+000000AF: E090 It RZ5, 0200 Ioad imncdiate 43 WATCHDOG
Waiths LED DELAY
+000000B0:  S4DEDOEF ~ CALL 020000008F Call subroutine
oop
+000000B2:_ 940C0094  JHP 0200000034 Junp
finnannes . asme crr Glrbal Jntarrunt Disshls
1
S Projeat | Processor |
Loaded plugin STKS00
o83
: .08)
<l |
T5uild | @ Message [ Find inFles | FQ Breakpoints and Teacepoints

ATmegazséd  JTAGICEMKI  Auto Stopped & CAP NUM OVR

fsen| mEO@ S LDOE R | @rbox... | (@ 220 | ) vahoo!...| @ 5Fr... o] Blevors..|Fg2sr. o @weou...| | 2wi. -] G sope.. | Tomue...| 1926, | 18 windo... | f 2¢a.. o § apant o[ AvRs. [« B @ my) s26em
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Select Disassembler option from the View menu. This will hide the disassembly and the editor will
show only the BASIC source code:

AVR Stud embler] 18|
71 File Projec Build Edit | View | Tools Debug Window Help -
NEHS 8 8RR Toolbars EX B AE @A NED B i

Status Bar
o tace EES0 DT R24_0=ED Toad imnediate
Output Bo5t ouT 0204, k24 Out to 10 location
Name _Porth = Portb_init
Program Courter | 000034 e [EFe0 finid R24, 02FD Load innediate
9 ouT 006, R24 Out to /0 locat

‘Stack Pointer B21FF Watch Alt+1 bset RED_LED * uee cemten 11 AD_CONVERT

Xponter 0d021FE A A - 005, 6 Clear bit in 170 register 1 ANALOG COM

Y porter 0002100 egpn ¥in A4 Liths 1ED_DELAY

Yot w21 | e a@wor o

poey R25, 0x00 Load immediate «EcPU
Cycle Counter 0 Memory Window 3 BitMs IED_DELAY -+ B eEPROM
Frequency. Register S plosoe. tan 0x0000008F Call subroutine ) EXTERNAL I
Stop Watch X E90TAG
100000039 ak2E iy 0056 Set bit in 10 register &
SREG DOEEO0AD VaitMs LED_DELAY 4/ =2 PORTA
4 Regsters +000000%4:  EFY R24. UxFA Load innediate )2 PORTB
A2
+0000009B: E030 DI RZ5. 0200 Ioad innediate 5 poRTe
10 Waiths LED_DELAY A=
+0000009C:  94DEDOEF _  CALL 02000000BF Call subroutine 128 PORTD
Reset YELLOV_LED 452 PORTE
+0000009E: _a82C CBI 005, 4 Clear bit in 1/0 register 8 FORTF
143 Waiths IED_DELAY =
+0000009F:  EFBA DI R24. U=FL Load innediate 212 PORTG
+000000AD: _ED RZE. 0200 Ioad innediate 452 PORTH
Waitlis IED DELAY 28 roRTy
+000000A1: _340EDOEF ~ CALL 00000008 Call subroutine =
S=t YELLOW_LED 2FE PORTK
+000000A3: 9A: = 0205, 4 Set bit in 10 register 4 E2 PORTL
Waiths LED_DELAY =t
+000000A4:  EF R24. 02FL Load innediate =
+00000DA5:  E030 D1 R25, 0x00 Toad imnediate 2 TIMER COUN
Waitls IED_DELAY 49 TIMER_COUN
+000000k6: G40EO0EF  CALL 0200000088 Call subroutine B TIMER_COUN
47 Reset GREEN_LED 216 TMER_CoUN
+00000048 0055 Clear bit in 170 register 2 L
48 Waitlis LED_DELAY 2/ TIMER_COUN
+000000A3:  EF8A DI R24, 02FL Load imnediate 8 TIMER_COUN
+000000KA°  E030 DI R25. 0200 Ioad innediate 3w
1 aiths LED_DELAY 3
+000000AB:  940ED0BF __ CAIL 0=000000BF Call subroutine 81 USARTO
hooomn: S5iab - 02055 et b 10 S
+ 205, =t bit in 10 register us
5 Waiths TED_DEIAY 22 USART2
+000000AE:  EF! R24, DxFh Load inmediate 287 USART3
+000000AF: E090 It RZ5, 0200 Ioad imncdiate 43 WATCHDOG
Waiths LED DELAY
£000000B0 A0EQDEF © CALL 020000008F Call subroutine
oop
+000000B2:_ 940C0094  JHP 0200000034 Junp
finnannes . asme crr Glrbal Jntarrunt Disshls
1 il
S Projeat | Processor | d4b
es: v x
Loaded plugin STKS00
o83
: .08)
<l |
5uid | @ Message [ 5] Find in Files | F3 Breakpaints and Tacepoints
ATmega2S60  JTAGICEMKI  Auto Stopped & CAP NUM OVR

fsen| mEG @GSO R

| @rbox... | (@ s22%... | ) vahoot...| @5 .. <]

192.16.

8 windo... | f 2ea. +| § arant -[[p avrs. [« B G R0 s26em

eror 1. | Bg2se.. | @orom...| | 2wi.. o sope... | Toemus...|
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AVR Stud \Users\oguz\Documents\BIPOM\th1led bas]
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The program execution is now stopped at the breakpoint. Select Step Over under Debug menu
( F10 key does the same thing ). This will move the yellow arrow to the next code line. Yellow
arrow indicates the current program position in BASIC source code.
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Selecting Run under Debug menu will make the program run again until it reaches the breakpoint
line:
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You can clear the breakpoint three different ways:
1) Click the mouse on the line that contains the breakpoint and press F9.

2) Click the mouse on the line that contains the breakpoint and select Toggle Breakpoint
under Debug menu.

3) Click the mouse on the line that contains the breakpoint and then right click the mouse.
This will bring up a menu. Select Toggle Breakpoint from that menu.
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After the breakpoint has been cleared, if you select Run under Debug menu, the program will
continue to run without stopping at any breakpoints ( because we cleared the only breakpoint that
we added ).
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To stop the program while it is executing, select Break under Debug menu. The yellow arrow in
the editor will show where the program execution stopped when Break occurred.
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